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Audience
This guide is intended primarily for data center administrators with responsibilities and expertise in one or
more of the following:

• Server administration

• Storage administration

• Network administration

• Network security

Conventions
IndicationText Type

GUI elements such as tab titles, area names, and field labels appear in this font.

Main titles such as window, dialog box, and wizard titles appear in this font.

GUI elements

Document titles appear in this font.Document titles

In a Text-based User Interface, text the system displays appears in this font.TUI elements

Terminal sessions and information that the system displays appear in this
font.

System output
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IndicationText Type

CLI command keywords appear in this font.

Variables in a CLI command appear in this font.

CLI commands

Elements in square brackets are optional.[ ]

Required alternative keywords are grouped in braces and separated by vertical
bars.

{x | y | z}

Optional alternative keywords are grouped in brackets and separated by vertical
bars.

[x | y | z]

A nonquoted set of characters. Do not use quotation marks around the string or
the string will include the quotation marks.

string

Nonprinting characters such as passwords are in angle brackets.< >

Default responses to system prompts are in square brackets.[ ]

An exclamation point (!) or a pound sign (#) at the beginning of a line of code
indicates a comment line.

!, #

Means reader take note. Notes contain helpful suggestions or references to material not covered in the
document.

Note

Means the following information will help you solve a problem. The tips information might not be
troubleshooting or even an action, but could be useful information, similar to a Timesaver.

Tip

Means the described action saves time. You can save time by performing the action described in the
paragraph.

Timesaver

Means reader be careful. In this situation, you might perform an action that could result in equipment
damage or loss of data.

Caution
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IMPORTANT SAFETY INSTRUCTIONS

This warning symbol means danger. You are in a situation that could cause bodily injury. Before you
work on any equipment, be aware of the hazards involved with electrical circuitry and be familiar with
standard practices for preventing accidents. Use the statement number provided at the end of each warning
to locate its translation in the translated safety warnings that accompanied this device.

SAVE THESE INSTRUCTIONS

Warning

Related Cisco UCS Documentation
Documentation Roadmaps

For a complete list of all B-Series documentation, see theCiscoUCS B-Series Servers Documentation Roadmap
available at the following URL: http://www.cisco.com/go/unifiedcomputing/b-series-doc.

For a complete list of all C-Series documentation, see theCiscoUCSC-Series Servers Documentation Roadmap
available at the following URL: http://www.cisco.com/go/unifiedcomputing/c-series-doc.

For information on supported firmware versions and supported UCS Manager versions for the rack servers
that are integrated with the UCS Manager for management, refer to Release Bundle Contents for Cisco UCS
Software.

Other Documentation Resources

Follow Cisco UCS Docs on Twitter to receive document update notifications.

Documentation Feedback
To provide technical feedback on this document, or to report an error or omission, please send your comments
to ucs-docfeedback@cisco.com. We appreciate your feedback.
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C H A P T E R  1
New and Changed Information

This chapter includes the following sections:

• New and Changed Information, page 1

New and Changed Information
The following tables provide an overview of the significant new features and behavioral changes to the Cisco
UCS Platform Emulator. The tables do not provide an exhaustive list of all changes or of the new features in
each release.
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Table 1: New Features and Significant Behavioral Changes in Cisco UCS, Release 3.1(2bPE1)

DescriptionNew or Changed Feature

Following new hardware features are added:

1 Chassis:

1 Cisco UCS C3260 system

2 Storage Servers:

a UCSC-C3X60-SVRNB

b UCSC-C3K-M4SRB

3 Blade Server:

1 UCSB-EX-M4-3

4 Rack Servers:

1 HX220C-M4S

2 HX240C-M4SX

5 Storage Controllers:

1 UCSC-C3X60-HBA

2 UCSC-C3X60-R4GB

3 UCSC-C3K-M4RAID

6 NVMe-based PCIe storage options:

1 HGST HH-HL PCIe cards

2 Intel HH-HL PCIe cards

3 HGST 2.5” PCIe SSDs

4 Intel 2.5” PCIe SSD

New Hardware support
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DescriptionNew or Changed Feature

Following new software features are added:

1 Disk Zoning

2 Chassis Profile

3 Storage Profile for C3260 system

4 New Templates:

• C3K M4SRB High

• C3X60 SVRNB High

• HX220C M4S Medium

• HX240C M4SX Medium

5 Chassis level Templates (Pre-configured chassis with
servers and other components on the control panel):

• UCSC-C3X60-BASE - 2 servers

• UCSC-C3X60-BASE - server andHDDExpansion
tray

• UCSC-C3X60-BASE - IO Expander and
UCSC-C3K-M4SRB

6 Chassis peer device (Option to select the peer device for
C3260 chassis - Fabric Extender or Fabric Interconnect)

New software features

Removed support for UCSME-4308 system.Changes and limitations

Table 2: New Features and Significant Behavioral Changes in Cisco UCS, Release 3.1(1ePE1)

DescriptionNew or Changed Feature

Following new features are added:

1 Emulation of full scale setup

2 Dynamic insertion, removal and modification of
components that requires no restarting of Cisco UCS
Platform Emulator.

3 Unified release supporting all platforms and components
such as Classic, UCS Mini, UCS Modular Servers

New Features
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DescriptionNew or Changed Feature

Following new GUI features are added:

1 Summarized view of configured inventory helps in
viewing exhaustive settings

2 Focus view for each device with filtered catalog to
configure components easily

3 New menu bar

4 Configure topology with Manage links module to
configure customized and automatic connections

5 Import connectivity and cluster information from saved
configuration and Live UCS

6 Easy to duplicate new devices (Chassis, Fex and Servers)
and quickly create extensive set-ups

7 Easy to add pre-configured devices using templates

8 Inserting and removing of all devices in a single instance

9 Navigation pane for quick and easy access

10 Configure all devices to insert automatically upon restart

11 Add components for devices in bulk using range inputs

New Graphic User Interface Features

1 Customize statistics for devices with
fixed/random/incrementing values

2 Set clock and NTP server from UCSPE CLI

3 SmartPlay Bundle Configurations are not supported

4 Removed loading configuration from a startup URL

5 Removed SD Card and TPM support

6 Removed Dynamic Fault Injection feature

Changes and limitations
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Table 3: New Features and Significant Behavioral Changes in Cisco UCS, Release 2.5(2aPE1)

DescriptionNew or Changed Feature

Following new hardware features are added:

1 Compute Modular Servers:

1 Cisco UCSME-1414 1 Socket Server

2 Cisco UCSME-2814 2 Socket Server

2 CPUs:

a UCS-CPU-E31231D

b UCS-CPU-E31241D

c UCS-CPU-E31271D

d UCS-CPU-E31281D

e UCS-CPU-E52630D

f UCS-CPU-E52640D

g UCS-CPU-E52650D

h UCS-CPU-E52660D

3 DIMMS:

1 UCS-MR-1X081RU-A

2 UCS-MR-1X162RU-A

New Hardware support

Following new software features are added:

1 Templates (pre-configured cartridges with servers on the
control panel) for New Modular Servers

• ME1414 High

• ME2814 Medium

• ME2814 High

2 Added TPM/TXT support for the new modular servers
UCSME-1414 and UCSME-2814

New software features

Cisco UCS Releases 2.5(2aPE1) and 2.5(1aPE1) support configuration only for the UCS chassis
UCSME-4308 and its components.

Note
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Table 4: New Features and Significant Behavioral Changes in Cisco UCS, Release 2.5(1aPE1)

DescriptionNew or Changed Feature

Following new hardware features are added:

1 UCS Chassis - UCSME-4308 is a new chassis for
modular servers which supports resource sharing such
as adaptors and storage. It has a single IOM
(UCSME-4308).

2 Compute Modular Server -Cisco UCSME-142-M4
Socket Server ( UCSME-142-M4)

3 DIMM - UCS-MU-1X082RY-F

4 Storage Disks:

1 UCS-SD240G0KS2-EV

2 UCS-SD480G0KS2-EV

3 UCS-SD960G0KS2-EV

4 UCS-SD400G0KS2-EP

5 UCS-SD800G0KS2-EP

6 UCS-SD16T12S2-EP

5 CPUs:

1 UCS-CPU-E31220LD

2 UCS-CPU-E31240LD

3 UCS-CPU-E31275LD

6 Storage controller - Cisco 12G SAS Modular Raid
Controller (UCSME-MRAID12G)

New Hardware support

1 Modifications to the VM Console login

2 Modifications to the VM Console Options Menu

3 Modifications to the Network Settings

4 Modifications to the System Settings

5 More details added to the Status Summary display

Changes to the Cisco UCS Platform Emulator
VM console
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DescriptionNew or Changed Feature

Following new software features are added:

1 Templates (pre-configured cartridges with servers on the
control panel) for New Modular Servers

• ME142 M4 Low

• ME142 M4 Medium

• ME142 M4 High

2 New tab for modular servers

3 Support for storage profile operations:

• Creation of a Logical Unit Number (LUN)

• Deletion of a LUN

• Modification to a LUN

• Hot Spare addition

• Removal of Hot Spares

New software features

Table 5: New Features and Significant Behavioral Changes in Cisco UCS, Release 2.2(5aPE1)

DescriptionNew or Changed Feature

Added Haswell CPUs to the catalog.New Hardware support

Added support for time zone management.New Software support

Added support for the following Blade servers:

• UCSB-B420-M4

• Cisco UCS Scalable M4 Blade Module for
UCSB-EX-M4-2 Blade Server

New Blade Server support

Added support for the UCSC-PCIE-Q8362 network
adapter.

New network adapter support

The UCSB-EX-M4-2 Blade Server can be added in
scaled (4S) or non-scaled (2S) mode.

Scaled mode servers

Cisco UCS Platform Emulator User Guide, Release 3.1 (2ePE1)    
7

New and Changed Information
New and Changed Information



DescriptionNew or Changed Feature

Added the following templates for UCSB-B420-M4,
UCSC-C460-M4 , UCSB-EX-M4-1 and
UCSB-EX-M4-2 servers:

1 B420M4High

2 C460M4High

3 ExM4ScaledHigh

4 ExM4NonScaledHigh

5 ExM42ScaledHigh

6 ExM42NonScaledHigh

New templates

Table 6: New Features and Significant Behavioral Changes in Cisco UCS, Release 2.2(4bPE1)

DescriptionNew or Changed Feature

Added support for the following network adapters:

• UCSC-MLOM-C10T-02

• UCSB-MEZ-BRC-02

• UCSC-PCIE-C10T-02

New Network Adapter support

1 Added support for N2K-C2232TM-E-10GE

2 New tabRack Integration in the navigation pane
of UCS Platform Emulator control panel. It allows
to select the desired FEX model and change the
modes of Direct Connect Rack and Single Wire
Management.

3 Added notes on Single Wire Management and
Direct Connect Rackmode regarding newly added
supported UCS C-series adapters and FEX.

New Fabric Extender Support
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DescriptionNew or Changed Feature

1 Added support for the following storage profile
operations:

• Creation of a Logical Unit Number (LUN)

• Deletion of a LUN

• Modification to a LUN

• Hot Spare addition

• Removal of Hot Spares

2 Added notes on Storage Controller and Adapter
addition.

3 Added the following new templates containing
UCSC-MLOM-C10T-02 and
UCSC-PCIE-C10T-02 adapters:

• C220M4LMedium

• C240M4LMedium

4 Added notes on templates, importing from XML
and loading a saved hardware configuration

New Software Features

1 Modifications to the VM Console login

2 Modifications to the VM Console Options Menu

3 Modifications to the Network Settings

4 Modifications to the System Settings

5 More details added to the Status Summary display

Changes to the Cisco UCS Platform Emulator VM
console

Table 7: New Features and Significant Behavioral Changes in Cisco UCS, Release 2.2(3aPE1)

DescriptionNew or Changed Feature

Added support for the Cisco UCSB-B200-M4 Blade ServerNew blade server support
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DescriptionNew or Changed Feature

Added support for the following Rack Servers:

1 Cisco UCSC-C220-M4S

2 Cisco UCSC-C220-M4L

3 Cisco UCSC-C240-M4S

4 Cisco UCSC-C240-M4L

5 Cisco UCSC-C240-M4S2

6 Cisco UCSC-C240-M4SX

New rack-mount server support

Added support for the following network adapters:

1 UCSB-MLOM-40G-03

2 UCSC-MLOM-CSC-02

3 UCSB-VIC-M83-8P

New network adapter support

Provides additional flexibility to configure the connectivity
between IOM and Fabric Interconnect. You have to
configure the port numbers. It also supports Direct Connect
Rack feature.

Configure IOM links

Whenever you perform a configuration change on the control
panel, the DB persistence gets automatically set to reset DB.

Change of DB persistence

UCSPE from release 2.2(3aPE1) onwards allows
configuration of multiple and different adapters on a rack
server.

Extended direct connect Rack

Default Hardware configuration contains a mix of M3 and
M4 blade and rack servers.

Default Configuration Change
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DescriptionNew or Changed Feature

Added the following new templates for UCSB-B200-M4,
UCSC-C240-M4L/M4S/M4S2/M4SX, and
UCSC-C220-M4L/M4S servers:

1 B200M4Large

2 B200M4Low

3 B200M4Medium1

4 B200M4Medium2

5 B200M4Medium3

6 B200M4Medium4

7 C220M4SHigh

8 C220M4SMedium1

9 C220M4SMedium2

10 C240M4SXMedium

11 C240M4SXHigh1

12 C240M4SXHigh2

New templates

Table 8: New Features and Significant Behavioral Changes in Cisco UCS, Release 2.2.(2cPE1)

DescriptionNew or Changed Feature

Added support for the Cisco UCS Scalable M4 Blade
Module for the UCSC-B260-M4 or UCSC-B460-M4 Blade
Server

New blade server support

Added support for the Cisco UCSC-C460-M4 Rack ServerNew rack-mount server support

Supports the following storage accelerators:

1 Cisco UCS UCSB-F-LSI-400S storage accelerator

2 Cisco UCS UCSB-F-LSI-800S storage accelerator

3 Cisco UCS UCSB-F-FIO-785M storage accelerator

4 Cisco UCS UCSB-F-FIO-365M storage accelerator

New storage accelerator support

Creates mounting points on the Cisco IMC.Mounts are only
configured and not actually mounted.

Scriptable vMedia

Added a new tab called Storage Controllers under Startup
Inventory. You can drag and drop the storage controllers
on the rack-mounted servers or blade servers.

Storage controllers
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DescriptionNew or Changed Feature

The Cisco UCS Scalable M4 Blade Module can be added
in scaled (4S) or non-scaled (2S) mode.

Scaled mode servers

The default configuration is changed to M3 blade and
rack-mounted servers.

Default configuration

Table 9: New Features and Significant Behavioral Changes in Cisco UCS, Release 2.2.(1bPE1)

DescriptionNew or Changed Feature

Connecting rack servers to the switch in Direct Connect
Rack mode is now supported.

Added a new tab called Direct Connect Rack under the
Navigation Pane of theUCS Platform Emulator Control
Panel.

Direct connect rack

From release UCS PE 2.2 (1bPE1) onwards, download of
only the stripped-down version of UCS firmware is
supported. The stripped-down version is approximately 50
KB in size with essential firmware upgrade information.

Stripped-down firmware image

Download of UCS Manager firmware from a local file
system is now supported.

Download from local file system

Supports the following SmartPlay Bundles:

1 B200_Entry_Plus_UCS_SP7_B200EP

2 B200_Entry_UCS_SP7_B200E

3 B200_Performance_UCS_SP7_B200P

4 B200_Value_Plus_UCS_SP7_B200VP

5 B200_Value_UCS_SP7_B200V

6 B420_Value_UCS_SP7_b420v

7 SWM_C220_Value_Plus_UCS_SP7_c220VP

8 SWM_C220_Value_UCS_SP7_C220V

9 SWM_C240_Performance_UCS_SP7_C240P

10 SWM_C240_Value_UCS_SP7_C240P

SmartPlay bundles

Statistics are generated for the following component:

1 Compute servers—motherboard temperature stats,
motherboard power stats, and processor environment
stats

Random statistics generation
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DescriptionNew or Changed Feature

SD card slot in Compute servers is now supported. You can
now upgrade the SD card firmware.

SD card support

Inducing and clearing faults using Command Line Interface
(CLI) and observing the fault behavior in the Cisco UCS
Manager GUI is now supported.

Dynamically inducing and clearing faults

The Second-level boot order feature is now supported. You
can specify this feature in the service profile of the UCS
servers during association.

Second-level boot order support

The user-space NIC (usNIC) feature is now supported. You
can specify this feature in the service profile of the UCS
servers during association.

user-space NIC (usNIC)

Table 10: New Features and Significant Behavioral Changes in Cisco UCS, Release 2.1(2aPE1)

DescriptionNew or Changed Feature

Firmware download and upgrade is now supported. New
firmware can be downloaded either from the Cisco
Developer Network or any other source and installed on the
Platform Emulator. Upgrade of installed firmware is
supported only for B-Series and C-Series components such
as bios, adapter, Cisco IMC, and storage controller.
Installation can also be done using Host Firmware Pack and
Auto Install feature.

Auto Install feature supported

Added new tab called Single Wire Management under the
Navigation Pane of theUCS Platform Emulator Control
Panel

Single Wire Management

Added new tab calledTemplates underHardware Catalog
of theEmulator Settings tab. Templates are pre-configured
blade and rack servers with loaded equipments. You can
drag and drop the templates on either a rack box or chassis.
The templates merge with the present configuration and fail
only when:

1 There is an overflow of connections for FEXs

2 The template configuration is unable to occupy the slot
in the chassis

Templates

Options to add multiple objects in a single drag and drop
instance of equipments.

Adding multiple objects in a single instance
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DescriptionNew or Changed Feature

Option to enter slot range while adding:

1 DIMM, HDD, CPU, or PSU on rack servers and chassis

2 Fans on chassis

Range of slot numbers

Import of a configuration from a live-UCS system using
https is supported.

Secure import of configuration supported

Statistics are randomly for the following components:

1 Fabric Interconnect—envstats, Psu input-stats, sysstats,
Network stats

2 Chassis—Fan Stats, Psu input-stats

3 FEX—envstats

Random statistics generation

Added support for the following rack-mount servers:

1 Cisco UCS C260 M2 Rack Server

2 Cisco UCS C460 M2 Rack Server

3 Cisco UCS C420 M3 Rack Server

New rack-mount server support

Added support for Cisco UCS B-420 M3 Blade ServerNew blade server support

Added support for the following network adapters:

1 Cisco UCS CNA M73KR-E Emulex Adapter

2 Cisco UCS CNA M73KR-Q Qlogic Adapter

New network adapter support

Added a new icon under the working pane of Startup
Inventory page.

SmartPlay bundles

Moved Hardware InventoryMenu Tab from the
Navigation Pane to Emulator SettingsMenu Tab

Moved Hardware Inventory Menu Tab

Table 11: New Features and Significant Behavioral Changes in Cisco UCS, Release 2.1(1aPE1) and Release 2.1(1aPE2)

DescriptionNew or Changed Feature

Added cluster support with dual-fabric interconnects
simulated on the same virtual machine.

Cluster support

Added a validate configuration option in the GUI.Validation option

   Cisco UCS Platform Emulator User Guide, Release 3.1 (2ePE1)
14

New and Changed Information
New and Changed Information



DescriptionNew or Changed Feature

Added backup and restore configuration options.Backup and Restore

Added unified port support for the Cisco UCS 6248UP and
Cisco 6296UP fabric interconnects.

Unified port support

Added support for the following rack-mount servers:

1 Cisco UCS C200M1 High-Density Rack-Mount Server

2 Cisco UCS C200M2 High-Density Rack-Mount Server

3 Cisco UCS C210 M1 General-Purpose Rack-Mount
Server

4 Cisco UCS C210 M2 General-Purpose Rack-Mount
Server

5 Cisco UCS C250 M1 Extended-Memory Rack-Mount
Server

6 Cisco UCS C250 M2 Extended-Memory Rack-Mount
Server

7 Cisco UCS C220 Rack Server

8 Cisco UCS C240 Rack Server

9 Cisco UCS C22 Rack Server

10 Cisco UCS C24 Rack Server

New rack-mount server support

Added support for the following blade servers:

1 Cisco UCS B-22 Blade Server

2 Cisco UCS B-250 Blade Server

3 Cisco UCS B-440 Blade Server

New blade server support

Added support for the following network adapters:

1 Cisco UCS VIC M828P Virtual Interface Card

2 Cisco UCS VIC 1240 Virtual Interface Card

3 Cisco UCS VIC 1225 Virtual Interface Card

4 Emulex OCe11102-F Converged Network Adapter

5 Qlogic QLE8242 Converged Network Adapter

6 Broadcom NetXtreme II

New network adapter support
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DescriptionNew or Changed Feature

Added support for the Cisco Nexus 2232PP Fabric Extender.

Added an automatic rack server to fabric extender
configuration.

New Fabric Extender (FEX) support

Added information to use the vm console to change network
settings and to change the cluster status.

VM Console

Added requirement to use the Cisco UCS Platform Emulator
GUI only to change the persistent settings for the database
(to reset or to preserve the database upon a restart).

Database Persistence Settings

Added information to launch UCSPE using VMplayer,
VMfusion, VMware vSphere Hypervisor (ESXi) , and
Microsoft Hyper-V - on Windows or Linux.

Launching UCSPE

Updated requirements.System Requirements

Removed limitation about high availability mode.Known Issues

Table 12: New Features and Significant Behavioral Changes in Cisco UCS, Release 2.0(2s)

DescriptionNew or Changed Feature

Added an option to switch between standalone and cluster
modes for the emulated fabric interconnects.

Enhanced fabric interconnect high availability
support

Added support for the Cisco UCS B200 M3.New blade server

Added support for the Cisco UCS 6248 and 6296 fabric
interconnects.

New fabric interconnects

Added support for the Cisco UCS 2208XP I/O module.New I/O module

Added support for 1, 2, 4, or 8 uplinks from an I/O module
to a fabric interconnect.

Enhanced connectivity between I/O modules
and fabric interconnects
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C H A P T E R  2
Overview

This chapter includes the following sections:

• Information About Cisco UCS Platform Emulator, page 17

• Cisco UCS Platform Emulator Control Panel, page 17

Information About Cisco UCS Platform Emulator
Cisco UCS Platform Emulator is the Cisco UCS Manager application bundled into a virtual machine (VM).
The VM includes software that emulates hardware communications for the Cisco Unified Computing System
(Cisco UCS) hardware that is configured and managed by Cisco UCS Manager.

For example, you can use CiscoUCS PlatformEmulator to create and test a supported CiscoUCS configuration,
or to duplicate an existing Cisco UCS environment for troubleshooting or development purposes.

For the latest hardware and software feature information, prerequisites, limitations, and caveats, see the
release notes for Cisco UCS Platform Emulator.

Note

Cisco UCS Platform Emulator Control Panel

Navigation Pane
The Navigation pane displays on the left side of the Cisco UCS Platform Emulator Control Panel. This pane
enables you to navigate to all components in the Cisco UCS Platform Emulator.

INVENTORY Menu Tab

The items in this menu tab appear in the form of Equipment hierarchy and enable you to access and configure
settings for Chassis, Fabric Extenders, Rack Servers, and Fabric Interconnects in Cisco UCS PlatformEmulator.

Cisco UCS Platform Emulator User Guide, Release 3.1 (2ePE1)    
17



Work Pane
TheWork pane displays on the right side of Cisco UCS Platform Emulator Control Panel. TheWork pane
includes a content area that displays information related to the menu item selected in the Navigation pane.
This comprises theMenu bar that contains the icons and theHardware Inventory Dashboard that contains
the list of chassis, rack servers, fabric extenders, fabric interconnects, blade servers and modular servers. You
can view and modify information in theWork pane.

Hardware Inventory Dashboard
The inventory of supported hardware components is stored and displayed in the Hardware Inventory dashboard.
It contains the inventory of the supported components that you can use to build a chassis in Cisco UCS Platform
Emulator, including servers, fabric interconnects, and fabric extenders.

Hardware Inventory Menu and Dashboard Icons

The following table contains the icons above the Dashboard area and the icons used to perform functions
such as editing and removing a device, duplicating a device and adding a new device.

DescriptionFunctionIcon

Adds a chassis, rack server or fabric extender.Add New Device

Duplicates the selected device.Duplicate

Opens the hardware inventory focus page where you can edit or
modify the device you selected.

Edit Device

Removes a device from the Emulator.Delete Device

Adds a template to create a chassis or a rack server.Add New Template
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DescriptionFunctionIcon

Loads a previously saved hardware inventory configuration. After
you restart Cisco UCS Platform Emulator, this configuration
overwrites and replaces the current hardware inventory. You can
also perform the following using this icon:

• Load from a File— Import an XML file that contains
hardware inventory configuration data from a file on the local
disk.

• Import from a Live UCS— Imports the hardware inventory
configuration from a live Cisco UCS Domain.

Load from a SavedXML

Restarts Cisco UCS Platform Emulator to enable the emulated Cisco
UCSManager to discover the new hardware inventory configuration.
You can also perform the following using this icon:

• Factory Reset—Resets all settings to original configuration.

• Reboot UCSPE— Reboot Cisco UCS Platform Emulator.

• Shut down UCSPE— Shut down Cisco UCS Platform
Emulator.

Restart Cisco UCS
Platform Emulator

Saves the current hardware inventory configuration. A file with this
name displays in the Load previously saved configuration list.
You can also perform the following using this icon:

• Export Configuration as XML File— Exports the current
hardware inventory configuration as an XML file then opens
a new browser tab and displays the contents of the XML file.

Save the Configuration

Validates the configuration by checking if the device (chassis, fabric
expander, rack/blade/modular server and so on) is fully equipped
with the required components, and reports the missing components
of all the configured devices.

Validate the present
Configuration

Allows you to view the hardware components supported in Cisco
UCS Platform Emulator.

Hardware Catalog

Displays the current status and a summary of the Cisco UCS
Platform Emulator settings. These settings are updated when you
modify any of the Cisco UCS Platform Emulator settings.

Status Summary
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DescriptionFunctionIcon

Displays the Managed Object Browser, or Visore, that you can
access through Cisco UCS Platform Emulator to get a graphical
view of the managed objects in the XML database. You can also
perform the following using this icon:

• APIModel Documentation—Allows you to access the Cisco
UCS Manager XML API Documentation.

• UCS PowerTool Download— Allows you to integrate,
automate, and orchestrate all aspects of Cisco UCS
management within the data center.

• UCS CDN— Provides information, documentation, and
support resources for developers working with Cisco UCS.

• Online Help— Allows you to view the online help for Cisco
UCS Platform Emulator.

Managed Object
Browser

Allows you to modify the UCS high availability Settings and fabric
interconnect selection.

Settings

Opens Cisco UCS Manager.Open UCS Manager

Allows you to configure statistics for component usage in Cisco
UCS Platform Emulator.

Configure Statistics
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C H A P T E R  3
Installing and Running Cisco UCS Platform
Emulator Using the VM Console

This chapter includes the following sections:

• IP Address for Cisco UCS Platform Emulator, page 21

• Installing and Launching Cisco UCS Platform Emulator, page 22

• Launching Cisco UCS Platform Emulator Using Hypervisors, page 22

• Viewing System Settings Using VM Console, page 25

• Modifying System Settings Using VM Console, page 26

• Modifying Network Settings Using the VM Console, page 26

• Restarting and Rebooting Cisco UCS Platform Emulator Using the VM Console, page 27

• Starting the Cisco UCS Manager CLI Using the VM Console, page 28

IP Address for Cisco UCS Platform Emulator
Cisco UCS Platform Emulator supports both DHCP and static IP. By default, Cisco UCS Platform Emulator
is configured to use the local network to obtain an IP address via DHCP. If your network does not include a
DHCP server, you must assign a static IP address to Cisco UCS Platform Emulator.

After the initial installation completes, Cisco UCS Platform Emulator displays the management IP address in
the VM console. If you assign a static IP address, the IP address persists across VM reboots. If the IP address
was assigned by DHCP server, the IP address persists across VM reboots for the duration of the lease.

When connecting to the UCS Platform Emulator VM Console through the SSH, we recommend that you
keep open a single session.

Note
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Installing and Launching Cisco UCS Platform Emulator

The VM performs a one-time installation process the first time it starts up. Allow the installation to
complete before you reboot the VM.

Note

Procedure

Step 1 Extract the Cisco UCS Platform Emulator .zip file and .ova file to a folder.
Step 2 Open or import the unzipped Cisco UCS Platform Emulator into a supported hypervisor, as required by the

hypervisor.
Do not continue with the next step until the VM has finished booting.

Step 3 (Optional) If you have a DHCP server setup, the Cisco UCS Platform Emulator requests for the IP addresses
from the DHCP server during startup (three IP addresses are requested) and the IP assigned is displayed on
the login screen. Enter this IP address in a supported Mozilla-based web-browser to open the home screen of
Cisco UCS Platform Emulator.

Step 4 (Optional) If you want to assign a static IP address to Cisco UCS Platform Emulator, do the following (you
are required to enter three IP addresses as described in step e):
a) In the VM console window, at the ucspe login prompt, enter ucspe and press Enter.
b) At the Password prompt, enter ucspe and press Enter.
c) At the Select prompt, enter n to change the network settings. A brief overview of current network settings

is displayed.
d) At theModify Connections prompt, enter y to modify connections.
e) At the Set Network Mode prompt, enter c to configure custom network.

Repeat the following steps f. and g. three times, one for each interface.

f) At the Enter <Interface> IP prompt, enter the static IP address to configure and press Enter.
g) At the Enter <Interface> Netmask prompt, enter the Netmask to configure and press Enter.
h) At the Enter Gateway IP prompt, enter the IP address of the default gateway press Enter.
After you enter the default gateway, the network interface reinitializes with your settings and the system
becomes accessible through the new IP address. To cancel an entry and return to the menu, press Ctrl+C.

Launching Cisco UCS Platform Emulator Using Hypervisors
You can launch Cisco UCS Platform Emulator using VMplayer, VMfusion, VMware vSphere Hypervisor
(ESXi), and Microsoft Hyper-V.

Launching Cisco UCS Platform Emulator Using Hypervisors With An .ova File

Using VMplayer on Microsoft Windows and Linux, Release 5.0:
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1 Download the VMware OVF Tool, Release 3.0.1 from VMware. You can download the tool from the
website.

2 When the download is complete, open your terminal or command prompt, navigate to where the VMware
OVF Tool was installed and run the following to convert the image to a VMX file:
ovftool <path_to_ova\UCSPE.ova> <path_to_store_converted_image\UCSPE.vmx>

The conversion begins and a progress window is displayed. When finished, you can use VMware player
to open the converted image and launch Cisco UCS Platform Emulator.

3 From the File menu on the VMware Player menu bar, select Open a Virtual Machine.

4 Browse to the folder where the VMX file was converted and double-click the VMX file to launch Cisco
UCS Platform Emulator.

Launching Cisco UCS Platform Emulator Using Hypervisors With a .zip File

The .zip file contains the VMX and VMDK files that can be used directly with VMware Player, VMware
Workstation and VMware Fusion.

1 Download the .zip file.

2 Extract the .zip file to a folder.

3 Click Open a Virtual Machine and browse to the extracted files. Select the VMX file and click Open..

4 To install in vSphere, the VMDK files must be processed with VMware Converter Standalone, then
deployed to vCenter directly.

5 Open VMware Converter Standalone.

6 In the Converter view pane, select Convert Machine

7 Set the source type as VMware Workstation or Other Virtual Machine.

8 Select the VMX file from the folder. Click Next.

9 Enter the destination information for the vCenter Server.

10 Select a destination cluster resource, and suitable datastore.

11 Click on Finish

12 When the conversion completes successfuly, power on the VM.

Launching Cisco UCS Platform Emulator Using Microsoft Hyper-V With a .zip File

This task applies to the .zip file only; for example,
Cisco_UCS_Platform_Emulator_3.1(2bPE1).zip. CiscoUCSPlatformEmulator is delivered
as an .ova file and as a .zip file. Each file contains the VMX and VMDK files that can be used directly
with VMware Player, VMware Workstation and VMware Fusion.

Note

1 Download the .zip file.

2 Extract the .zip file to a folder.
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3 Download the StarWindV2V converter fromwww.starwindsoftware.com. Install the converter inMicrosoft
Windows.

4 Launch the StarWind converter and convert the UCSPE.vmdk file into VHD or VHDX format. Use the
Microsoft Virtual PC growable image or VHDX as the destination image format.

5 Once you have a .vhd or .vhdx image for the platform emulator you would like to use, you can create a
new VM. On Windows 2012 R2, if you are using the Hypervisor Manager to create a VM, you can select
New > Virtual Machine from the Actions pane to launch the VMWizard and configure the VM with the
following settings:

1 Specify a name of your choice for the VM. Optionally, specify a different location to store your VM.

2 Specify Generation 1.

3 Set the startup memory to 1024 MB. Disable the use of dynamic memory..

4 Choose an available Virtual Switch.

Hypervisor switch settings should be configured before you configure the VM. There are options for
external, internal, and private switch configurations. If you wish to use internally configured IPs and NAT,
we recommend you refer to the Hyper-VNATConfiguration Document for more information. Additionally,
note that NAT is an available option on Windows build 14295 and later (Windows/Hyper-V Server 2012
and Windows 10).

Note

5 UnderConnect Virtual Hard Disk, selectUse an existing virtual hard disk and browse to your .vhd
or .vhdx file.

6 Once you have completed creating a VM, select Settings for the new VM, and select Add Hardware
> Network Adapter, and click Add.

7 For the new Network Adapter, select the same virtual switch you used in step number 4 and clickOK.

8 Repeat steps 6 and 7, and add a third network adapter. Verify that the VM is reporting three network
adapters on the desired Virtual Switch from the Networking summary tab, or by selecting Settings
again.

9 Select Start to start the VM after verifying the settings, and then selectConnect to connect to the VM
console.

10 Once the Cisco UCS Platform Emulator boot is complete, you can verify and/or modify IP settings.
Cisco UCS Platform Emulator supports both DHCP and static IP, and by default, is configured to use
the local network to obtain an IP address through the DHCP. If your network does not include a DHCP
server, you must assign a static IP address. To see the version number of Cisco UCS Platform Emulator
you are using, see the User Guide.

11 Once you configure the networking successfully, you can connect to the IP shown in the Cisco UCS
Platform Emulator VM console.

Launching Cisco UCS Platform Emulator Using VMware Fusion on Mac OS X With an .ova File

If you are running VMware Fusion 4 or below, you can use the VMware OVF Tool to convert the image to
the VMware runtime file format (.vmx). VMware Fusion 5 can import the .ova image file without conversion.
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1 From the File menu on the VMware Fusion menu bar, select Import. The Import Library window displays
a dialog box for browsing to the location of the .ovf file.

2 Browse to the .ova file and click Open.

3 Type the name for the imported virtual machine in the Save As text box and indicate where to save it. The
default destination is the Virtual Machines folder created by VMware Fusion.

4 Click Import. A status bar indicates the progress of the import process.

When the import is complete, the virtual machine appears in the virtual machine library and in a separate
virtual machine window.

Launching Cisco UCS Platform Emulator Using VMware Workstation on Microsoft Windows and Linux With
an .ova File

You can directly import an .ova file into VMware Workstation 8.

1 From the File menu on the VMware Workstation 8 menu bar, select Open.

2 Browse to the .ovf or .ova file and click Open.

3 Type a name for the virtual machine, browse to the directory for the virtual machine files, and click Import.

Launching Cisco UCS Platform Emulator Using VMware vSphere ESXi 5.0 With an .ova File

Connect to your VMware Vcenter or VMware vSphere ESXi using the vSphere client.

1 From the File menu in the Vcenter or ESXi menu bar, select Deploy OVF Template.

2 Browse to the .ova file and click Open.

Viewing System Settings Using VM Console
You can use the Cisco UCS Platform Emulator VM console to view system status and configurations.

Procedure

Step 1 At the ucspe login, enter the username ucspe and press Enter.
Step 2 At the Password prompt, enter ucspe and press Enter.

The VM console displays the Options menu.

Step 3 At the Select prompt, enter a to show the status and press Enter.
Multiple system statuses and configurations are displayed:

• The current version of Cisco UCS Platform Emulator is displayed on top.

• The current Network Mode and the Network Interface Configurations are displayed.
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Modifying System Settings Using VM Console
You can use the Cisco UCS Platform Emulator VM console to change some of the UCS Platform Emulator
configurations.

Procedure

Step 1 At the ucspe login, enter the username ucspe and press Enter.
Step 2 At the Password prompt, enter ucspe and press Enter.

The VM console displays the Options menu.

Step 3 At the Select prompt, enter t to modify system settings.
Step 4 At theModify System Settings, select one of the following options:

a) Enter h to modify High-Availability Mode and press Enter. The current status of the High Availability
Mode is displayed (Stand Alone or Clustered).
- At the Set High Availability prompt, enter s to change to Stand Alone or c to change to Clustered, and
press Enter. After modification, the Cisco UCS Platform Emulator and Cisco UCS Manager restart.

b) Enter t to modify system date/time and press Enter. The current date and time is displayed.
At the Change Date prompt, press y to change the date. If you choose not to change the date and skip to
Change Time instead, press n. Enter the new date in dd/mm/yyyy format and press Enter.

At the Change Time prompt, press y to change the time. If you choose not to change time and exit to the
main menu, press n. Enter the new time in hh:mm:ss format and press Enter.

c) Enter n to modify the Network Time Protocol (NTP) server settings.
At the prompt, enter the IP address of a valid Time Server running NTP. Cisco UCS Platform Emulator
connects to the Time server and synchronizes its system time with the server.

If you entered invalid data in the settings, the modification process aborts and the system reverts to
the original menu options.

Note

Modifying Network Settings Using the VM Console
You can use the Cisco UCS Platform Emulator VM console to change some network settings of the VM.

Procedure

Step 1 At the ucspe login, enter the username ucspe and press Enter.
Step 2 At the Password prompt, enter ucspe and press Enter.

The VM console displays the Options menu.

Step 3 At the Options Select prompt, enter n to modify network settings.
A brief summary of current network settings with the IP address, netmask and hardware address of the
interfaces, is displayed.
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Step 4 At theModify Connections prompt, enter y and press Enter.
Step 5 At the Set NetworkMode prompt, choose the network mode by entering a for AutoMode; d for DHCPMode

and c for Custom Mode.

• Auto Mode—This is the default mode of the Cisco UCS Platform Emulator. In this mode, the Cisco
UCS Platform Emulator checks for DHCP servers first as shown below.

• DHCP Mode—In this mode, the Cisco UCS Platform Emulator searches only for an available DHCP
Server. Upon obtaining IP addresses for all the interfaces, the Cisco UCS Platform Emulator and Cisco
UCS Manager restart automatically.

• Custom Mode— In this mode, the Cisco UCS Platform Emulator skips checking for available DHCP
servers and directly uses the custom configuration that the user provides. Complete steps a and b once
if Cluster Mode is Stand Alone, and thrice if Cluster Mode is Clustered.

a) At the Enter eth[0,1,2] IP prompt, enter the static IP address for the interface.
b) At the Enter eth[0,1,2] Netmask prompt, enter the netmask for the interface.
c) At the Enter Gateway IP prompt, enter the default gateway IP address.
The Cisco UCS Platform Emulator and Cisco UCS Manager restarts and come up with the configured IP
address.

Restarting and Rebooting Cisco UCS Platform Emulator Using
the VM Console

You can use the Cisco UCS Platform Emulator VM console to restart and reboot UCSPE.

Procedure

Step 1 At the cisco-ucspe login prompt, type username ucspe and press Enter.
Step 2 At the Password prompt, type ucspe and press Enter.

The VM console window displays the Options menu.

a) Press s to restart Cisco UCS Platform Emulator processes and press Enter. At the Confirm prompt, enter
y and press Enter. This restarts all the Cisco UCS Platform Emulator processes including the Cisco UCS
Manager process. The Cisco UCS Manager Database resets based on the configuration. (To change this,
see the Modifying System Settings Using VM Console, on page 26 section).

You should perform Cisco UCSManager backup operations to preserve the Cisco UCSManager
configuration through all the VM reboots.

Note

b) Press f to perform a Factory Reset and press Enter. At theConfirm prompt, enter y and press Enter. This
resets all configurations and settings to the original settings of the Cisco UCS Platform Emulator.

c) Press r to reboot the VM and press Enter. At the Confirm prompt, enter y and press Enter. This restarts
the VM.

d) Press x to logout user and press Enter. At the Confirm prompt, enter y and press Enter. This logs out
the current Cisco UCS Platform Emulator user and takes you back to the login screen.
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e) Press z to shutdown the VM and press Enter. At theConfirm prompt, enter y and press Enter. This shuts
down the VM.

Starting the Cisco UCS Manager CLI Using the VM Console
You can use the supported commands from the Cisco UCSManager CLI to configure andmanage the hardware
in your Cisco UCS Platform Emulator environment. The console window for the Cisco UCS Platform Emulator
VM supports a single CLI session.

For information about Cisco UCS Manager CLI commands, see the Cisco UCS Manager CLI Configuration
Guide and the Cisco UCS Manager CLI Command Reference. You can access these documents through the
Cisco UCS B-Series Servers Documentation Roadmap available at the following URL: http://www.cisco.com/
go/unifiedcomputing/b-series-doc .

Cisco UCS Platform Emulator does not support Cisco UCS Manager CLI commands for unsupported
features or within the connect nxos or connect local-mgmt scopes

Note

Procedure

Step 1 At the ucspe login prompt, type username ucspe and press Enter.
Step 2 At the Password prompt, type ucspe and press Enter.

The VM console displays the Options menu.

Step 3 Press c to log on to the CLI console and press Enter
The VM Console window now displays the ucspe# prompt, which is the equivalent of the top-level scope in
the Cisco UCS Manager CLI.
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C H A P T E R  4
Restarting and Shutting Down Cisco UCS
Platform Emulator Using the Control Panel

This chapter includes the following sections:

• Restarting Cisco UCS Platform Emulator, page 29

• Restarting Cisco UCS Platform Emulator and Performing a Factory Reset, page 29

• Rebooting the Cisco UCS Platform Emulator VM, page 30

• Shutting Down the Cisco UCS Platform Emulator VM, page 30

Restarting Cisco UCS Platform Emulator
Procedure

Step 1 In theWork pane, click the Power icon on the menu bar.
Step 2 Select Restart UCSPE.
Step 3 For the question Are you sure you want to restart UCS Emulator with Current Settings now?, select Yes

and click the Restart Cisco UCS Platform Emulator with current settings button to restart Cisco UCS
Emulator, or select No and click the Restart Cisco UCS Platform Emulator with current settings button
to cancel the restart.

Restarting Cisco UCS Platform Emulator and Performing a
Factory Reset

By default, when Cisco UCS Platform Emulator restarts, the database is erased, any hardware that you added
to Cisco UCS Manager within Cisco UCS Platform Emulator is deleted, and all configurations and settings
are returned to the factory defaults.
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Procedure

Step 1 In theWork pane, click the Power icon on the menu bar.
Step 2 Select Factory Reset.
Step 3 For the question Are you sure you want to perform Factory Reset now?, select Yes and click the Perform

Factory Reset button to restart Cisco UCS Platform Emulator with factory defaults, or select No and click
the Perform Factory Reset button to cancel the restart with factory defaults.

Rebooting the Cisco UCS Platform Emulator VM
Rebooting the VM from the Cisco UCS Platform Emulator ensures a clean shutdown of the Cisco UCS
Platform Emulator before the VM reboots.

If clustering is disabled, you must set a static IP address.Note

Procedure

Step 1 In theWork pane, click the Power icon on the menu bar.
Step 2 Select Reboot VM.
Step 3 For the question Are you sure you want to reboot Virtual Machine now?, select Yes and click the Reboot

Virtual Machine button to reboot Cisco UCS Platform Emulator, or select No and click the Reboot Virtual
Machine button to cancel the reboot.

Shutting Down the Cisco UCS Platform Emulator VM
Shutting down the VM from the Cisco UCS Platform Emulator ensures a clean shutdown of the Cisco UCS
Platform Emulator.

Procedure

Step 1 In theWork pane, click the Power icon on the menu bar.
Step 2 Select Shutdown VM.
Step 3 For the questionAre you sure you want to shut down Virtual Machine now?, selectYes and click the Shut

down Virtual Machine button to shut down Cisco UCS Platform Emulator, or select No and click the Shut
down Virtual Machine button to cancel the shutdown.

   Cisco UCS Platform Emulator User Guide, Release 3.1 (2ePE1)
30

Restarting and Shutting Down Cisco UCS Platform Emulator Using the Control Panel
Rebooting the Cisco UCS Platform Emulator VM



C H A P T E R  5
Configuring Cisco UCS Platform Emulator

This chapter includes the following sections:

• Viewing the Cisco UCS Platform Emulator Current Status and Settings, page 31

• Modifying the Cisco UCS Manager High Availability Setting, page 33

• Configuring Statistics in Cisco UCS Platform Emulator, page 34

• Modifying the Fabric Interconnect Emulation Settings, page 34

• Configuring Cisco UCS Platform Emulator Restart Settings, page 35

Viewing the Cisco UCS Platform Emulator Current Status and
Settings

Procedure

Step 1 In the Work pane, click the Status Summary icon from the menu bar.
Step 2 View the current status and settings of in the Status Summary page.

Status Summary Page
The Status Summary page displays the current status and a summary of the Cisco UCS Platform Emulator
settings. These settings are updated when you modify any of the Cisco UCS Platform Emulator settings.

Runtime Status Area

This area provides information about the current status of Cisco UCS Platform Emulator. The number in
parentheses shows the number of instances of the processes that are running. This example is for a cluster
setting. For a non-cluster (standalone setting), everything will be (1) and the SAM Controller will not be
running.
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DescriptionName

Running(1)Emulator field

Running(2)UCS Manager field

Running(2)Blade AG field

Running(2)RsdAG field

Running(2)PortAG field

Running(2)StatsAG field

Running(2)NicAG field

Running(2)DcosAG field

Running(2)HostagentAG field

Running(2)ExtvmmAG field

Running(2)SAM Controller field

The memory currently available to Cisco UCS Platform Emulator.Available Memory field

The current management IP address.Current Mgmt IP field

The netmask configured for Cisco UCS Platform Emulator.Netmask field

The gateway configured for Cisco UCS Platform Emulator.Gateway field

Management IP Settings Area

This area provides details of the management IP address configured for Cisco UCS Platform Emulator.

DescriptionName

Customized network mode.Network Mode field

IP address of the host.IP Address field

Specifies the network's subnet.Netmask field

Node that forwards packets to other networks.Default Gateway field

Emulator Startup Settings Area

This area provides details of the fabric interconnect configuration for Cisco UCS Platform Emulator.
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DescriptionName

The number of fabric interconnects configured for Cisco UCS Platform
Emulator. This can be one of the following:

• On

• Off

High-Availability Mode field

Emulator Hardware Config Area

DescriptionName

The location where the startup configuration for Cisco UCS Platform
Emulator is stored.

Startup Config URL field

NTP Settings Area

DescriptionName

Synchronizes time stamps of the system. This could be one of the
following:

• Synchronized

• Unsynchronized

NTP Server field

Current time and date.System Date/Time field

Record of the last NTP updates.Last NTP Update Log field

Modifying the Cisco UCS Manager High Availability Setting
The High Availability setting determines which of the following configurations is emulated by Cisco UCS
Platform Emulator:

• High availability cluster configuration with two fabric interconnects

• Single standalone fabric interconnect
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Procedure

Step 1 In theWork pane, click the Settings icon.
Step 2 Select Change Cluster State.
Step 3 On theModify UCS High Availability Settings and FI selection page, click one of the following radio

buttons:

• Dual Fabric Interconnect, HA

• Single Fabric Interconnect, no HA

Step 4 Click Submit.
This forcefully restarts Cisco UCS Platform Emulator for changes to take effect. Changing the mode resets
all the connections.

Configuring Statistics in Cisco UCS Platform Emulator
Procedure

Step 1 In theWork pane, click the Statistics icon from the menu bar.
Step 2 From the device hierarchy, select the desired device.

Configured statistics policies are displayed.

Step 3 To edit the policy of a specific statistic, click the Edit icon and select one of the policies:

• Fixed— allows you to set a fixed value.

• Random— allows you to set a random value.

• Increment— allows you to set an incrementing factor.

Step 4 Enter a value in the text box for the selected policy and click OK.
This changes the configuration for the statistics of that device.

Step 5 Click the Reset to Default button to reset the configuration.

Modifying the Fabric Interconnect Emulation Settings
This setting determines which fabric interconnect is used by Cisco UCS Platform Emulator.
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Procedure

Step 1 In theWork pane, click the Settings icon.
Step 2 Select Fabric Interconnect.
Step 3 On theModify UCS Fabric Interconnect Emulation Settings page, select the desired fabric interconnect

model from the Fabric Interconnect drop-down list.
Step 4 Click Submit.

This restarts the Cisco UCS Platform Emulator for changes to take effect.

Configuring Cisco UCS Platform Emulator Restart Settings
The Cisco UCS Platform Emulator Restart Settings allow you to configure settings for actions that are required
whenever the Platform Emulator restarts.

Modifying Insert Device Settings

You can use this setting when all devices need to be inserted once the Cisco UCS Platform Emulator restarts.
If the links of any device are not connected, they are automatically connected and then inserted into the Cisco
UCS Manager.

Procedure

Step 1 In theWork pane, click the Settings icon from the menu bar.
Step 2 Select UCSPE Restart Settings.
Step 3 Click the Yes radio button to insert all devices after a restart, or the No radio button to cancel the action.
Step 4 Click Submit.

Cisco UCS Platform Emulator User Guide, Release 3.1 (2ePE1)    
35

Configuring Cisco UCS Platform Emulator
Configuring Cisco UCS Platform Emulator Restart Settings



   Cisco UCS Platform Emulator User Guide, Release 3.1 (2ePE1)
36

Configuring Cisco UCS Platform Emulator
Configuring Cisco UCS Platform Emulator Restart Settings



C H A P T E R  6
Configuring the Hardware Inventory

This chapter includes the following sections:

• Viewing the Hardware Catalog, page 37

• Manually Configuring the Hardware Inventory, page 38

• Using Existing Hardware Inventory Configurations, page 47

Viewing the Hardware Catalog
Procedure

Step 1 On the Hardware Inventory Dashboard page, click the Hardware Catalog icon.
Step 2 In theWork pane, click one or more of the following tabs to view the components supported in the current

release:

• Fabric Interconnect

• Chassis

• DIMM

• IOM

• FEX

• Blade Servers

• Rack Servers

•Modular Servers

• CPU

• DIMM

• Disks

• Adaptors
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• Fans

• PSU

• Storage Controllers

Manually Configuring the Hardware Inventory
You can manually configure the hardware inventory in theWork pane using the options listed for hardware
components on the Hardware Inventory Dashboard.

Adding a New Chassis

Procedure

Step 1 On the Hardware Inventory Dashboard, click the Add Device icon next to the Chassis heading.
Step 2 In the Name field, enter a name for the chassis.
Step 3 In the Pid field, select a server from the drop down list.
Step 4 Click Add.

Cisco UCS Platform Emulator adds aChassis and the following message is displayed below theMenu icons:
Successfully created chassis with serial :: <Chassis serial>

Fabric Model UCS-FI-M-6324 is only supported with the chassis UCSB-5108-AC2 and
UCSB-5108-DC2. However, you can connect a secondary chassis N20-C6508 to the UCS Mini
chassis. To know how tomanage links between devices, seeManaging Connectivity of Links Between
Devices, on page 45.

Note

Creating a New Rack Server

Procedure

Step 1 On the Hardware Inventory Dashboard, click the Add Device icon next to the Rack Server heading.
Step 2 In the Name field, enter a name for the rack server.
Step 3 In the Pid field, select the type of server from the drop down list.
Step 4 Click Add.

Cisco UCS Platform Emulator adds a Rack Server and the following message is displayed below theMenu
icons:
Successfully created rack server :: <rack server name>, with serial :: <serial number>..

   Cisco UCS Platform Emulator User Guide, Release 3.1 (2ePE1)
38

Configuring the Hardware Inventory
Manually Configuring the Hardware Inventory



What to Do Next

Add a new template to the rack server you just created or an existing rack server. Click theAddNewTemplate
icon next to the Rack Server heading, select the rack server from a drop down list and click Add.

When you add a rack server, on the rack server's focus page, you can select the mode with which the rack
server connects, that is, it can directly connect to a fabric interconnect (DAS mode) or through a fabric
extender (SWM and DWM modes). To know how to manage links between devices, see Managing
Connectivity of Links Between Devices, on page 45.

Note

Creating a New Fabric Extender

Procedure

Step 1 On the Hardware Inventory Dashboard, click the Add Device icon next to the Fabric Extender heading.
Step 2 In the Name field, enter a name for the fabric extender.
Step 3 In the Side field, select side A or B from a drop down list.
Step 4 In the Pid field, select the fabric extender model from the drop down list.
Step 5 Click Add.

Cisco UCS Platform Emulator adds a Fabric Extender and the following message is displayed below the
Menu icons:
Successfully created Fex :: <fabric extender name>, with serial ::<serial number>.

To know how to manage links between devices, see Managing Connectivity of Links Between Devices, on
page 45.

Creating a New Blade Server
You can create a new blade server in theChassis area of the Chassis Focus page. However, a new blade server
does not contain any components, such as DIMMs, adapters, or fans. Once you create a new blade server,
you may edit the device from the Dashboard area to add the individual components.
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Procedure

Step 1 On the Hardware Inventory Dashboard, click the Edit Device icon for a chassis you select from the Chassis
list area.

Step 2 In the hardware catalog table in the Chassis Focus page, click on the blade server and, holding the mouse
button down, drag and drop it to the Chassis area.

Step 3 In the Enter Server Slot field, enter the number of the empty slot where you want to insert the blade server
and press Enter.

Step 4 (Optional) Click the Validate icon on the Dashboard to ensure that all necessary components for a server are
added. Missing components are displayed if the component is missing on the server.

Step 5 Complete the following steps to add the components to the blade server:
a) Click the Edit Device icon in the Blade Server area of the dashboard.
b) From the hardware catalog table on the Blade Server Focus page, click the desired component and, holding

the mouse button down, drag the component to the Server Slot area.
c) Enter the desired slot number for the component when prompted, and press Enter.
d) Repeat Steps a through c until you have added all desired components to the blade server.

For the UCS C3260 system, the following configurations are additionally supported:Note

• Server in slot 1 and HDD Expansion Tray in slot 2.

• Server (UCSC-C3K-M4SRB) in slot 2 and IO Expander in slot 1.

To know more about creating an HDD Expansion Tray and IO Expander, see Creating a
Hard Disk Drive Expansion Tray, on page 40 and Creating an IO Expander, on page 41.

Creating a Hard Disk Drive Expansion Tray
You can add a Hard Disk Drive (HDD) expansion tray from the chassis area.

Procedure

Step 1 On theHardware InventoryDashboard, click the Edit Device icon for a chassis you select from the Chassis
list area.

Step 2 In the hardware catalog table in the Chassis Focus page, click the disk and, holding the mouse button down,
drag and drop it to the Chassis area.

Step 3 In the Enter Disk Slot field, enter a slot in the range of 57-60.
Step 4 Press Enter.

Disks with the above range on a C3260 system represent the HDD expansion tray.
The HDD expansion tray gets added to slot number 2 on the C2360 Chassis if the slot is not already
occupied by a server.

Note
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Creating an IO Expander
You can create an IO expander in the Server area.

Procedure

Step 1 On the Hardware Inventory Dashboard, click the Edit Device icon for the UCSC-C3K-M4SRB server in
slot 2.

Step 2 In the hardware catalog table in the Server Focus page, click the disk or controller tab and, holding the mouse
button down, drag and drop either component to the Server area.

Step 3 In the Enter Slot field, enter a slot in the range 4-6 to add controllers, or enter a slot in the range 4-5 to add
disks.

Step 4 Press Enter.
Disks and controllers in the above ranges represent an IO Expander.

An IO Expander is created only if slot number 1 is empty, with UCSC-C3K-M4SRB in slot 2. It
occupies slot 1 of the chassis. Controller slot number 3 is used to connect the IO Expander with the
server. Therefore, in order to create an IO Expander, delete any controller in slot number 3.

Note

Modifying Hardware Components
After you create a chassis, server, or fabric extender, you can modify these components from their individual
areas in a dedicated Focus page that also includes aConnectivity area and the respectiveHardware Catalog
table located below.

You can arrive at the Focus page by clicking the Edit Device icon of the individual hardware component
from the hardware list on the Hardware Inventory Dashboard area.

Modifying Chassis Components

Procedure

Step 1 Click the Edit Device icon in the Chassis area of the Hardware Inventory Dashboard.
The Chassis Focus page is displayed.

Step 2 From the Hardware Catalog table on the Focus page, click the row for the desired component, drag the
component to the Chassis area, and drop it.

Step 3 When prompted, enter the desired slot number and press Enter.
Step 4 Repeat Steps 3 and 4 until you have added all the desired components.

On a chassis with PID UCSC-C3X60-BASE, an additional HDD Expansion Tray and IO Expander
are supported in a server slot. You may also add PSU and FANs. However, for other chassis PIDs,
only PSU and FANs are permitted to be dropped on the chassis.

Note
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Modifying Rack and Blade Server Components

Procedure

Step 1 Click the Edit Device icon in the Server area of the Hardware Inventory dashboard.
Step 2 From the hardware catalog table on the Focus page, click the row for the desired component, drag the

component to the Server area and drop it.
Step 3 When prompted, enter the desired slot number or a slot number range, and press Enter.
Step 4 Repeat Steps 2 and 3 until you have added all desired components.

Duplicating a Device
You can duplicate a server, fex, or chassis from the Hardware Inventory Dashboard or from the individual
component area on the Focus page.

Procedure

On the Hardware Inventory Dashboard, click the Duplicate Device icon in the fex, server, or chassis list
areas (tables).
Cisco UCS Platform Emulator duplicates the device and the following message is displayed below theMenu
icons:
Successfully duplicated <device> ::<serial number> to new <device> ::<serial number>

When you duplicate a device, Cisco UCS Platform Emulator duplicates all the components under it
(blades, DIMMs, disks, controllers and so on) and also assigns each component a unique serial
number.

Note

Inserting a Device into Cisco UCS Manager
You can insert a configured device into Cisco UCS Manager, which results in the discovery of the device.
The icons in the Insert/Remove column represent toggled status of each device. For example, an existing
inserted device is represented through the green icon. You are required to click this icon to remove the device
from UCS Manager. For more information on how to delete a device, see .

You can remove a device from two locations:

• From the Hardware Inventory Dashboard.

• From the Focus page of the device.

   Cisco UCS Platform Emulator User Guide, Release 3.1 (2ePE1)
42

Configuring the Hardware Inventory
Duplicating a Device



Procedure

Step 1 On the Hardware Inventory Dashboard, click the Insert/Remove icon from the desired hardware device's
table.

Step 2 When prompted, click the green Check Mark icon or the Red icon to remove the device or cancel the action
respectively.
Removing the device turns the status of the device to red, and you can insert the device into Cisco UCS
Manager.

Step 3 Return to the Hardware Inventory Dashboard and click the Edit Device icon.
Step 4 On the Focus page of the device, click the Insert/Remove icon on top of the page.
Step 5 When prompted, click the green Check Mark icon or the Red icon to remove the device or cancel the action

respectively.
Removing the device turns the status of the device to red, and you can insert the device into Cisco
UCS Manager. Removal of a device might take some time. We recommend you wait a few minutes
before attempting to re-insert. Blade and modular servers are removed when a chassis is removed
the Cisco UCS Manager.

Note

Removing a Device from Cisco UCS Manager
You can remove an inserted configuration fromCisco UCSManager. The icons in the Insert/Remove column
represent toggled status of each device. For example, an removed device is represented through the red icon.
You are required to click this icon to insert the device into Cisco UCS Manager. For more information on
how to insert a device, see Inserting a Device into Cisco UCS Manager, on page 42.

You can remove a device from two locations:

• From the Hardware Inventory Dashboard.

• From the Focus page of the device.

Procedure

Step 1 On the Hardware Inventory Dashboard, click the Insert/Remove icon from the desired hardware device's
table.

Step 2 When prompted, click the green Check Mark icon or the Red icon to insert the device or cancel the action
respectively.
Inserting the device turns the status of the device to green, and you can remove the device from Cisco UCS
Manager.

Step 3 Return to the Hardware Inventory Dashboard and click the Edit Device icon.
Step 4 On the Focus page of the device, click the Insert/Remove icon on top of the page.
Step 5 When prompted, click the green Check Mark icon or the Red icon to remove the device or cancel the action

respectively.
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Inserting the device turns the status of the device to freen, and you can remove the device from Cisco
UCS Manager. Removal of a device might take some time. We recommend you wait a few minutes
before attempting to re-insert. Blade and modular servers are removed when a chassis is removed
the Cisco UCS Manager.

Note

Inserting or Removing a Device in Cisco UCS Platform Emulator
You can insert into or remove a configured device from Cisco UCS Manager, resulting in discovery of the
device, or removal of the device from Cisco UCSManager. The icons in the Insert/Remove column represent
the toggled status of each device. For example, an existing inserted device is represented through the green
icon. You are required to click this icon to remove the device from UCS Manager. A removed device is
represented through the red icon and you are required to click this icon to insert the device into UCSManager.

You can insert or remove a device from two locations:

• From the Hardware Inventory Dashboard.

• From the Focus page of the device.

Procedure

Step 1 On the Hardware Inventory Dashboard, click the Insert/Remove icon from the desired hardware device's
table.

Step 2 When prompted, click the green Check Mark icon or the Red icon depending on its original status to either
insert or remove the device, or cancel the action respectively.

Step 3 Return to the Hardware Inventory Dashboard and click the Edit Device icon.
Step 4 On the Focus page of the device, click the Insert/Remove icon on top of the page.
Step 5 When prompted, click the green CheckMark icon or the Red depending on its original status to either insert

or remove the device, or cancel the action respectively.
Removal of a devicemight take some time.We recommend youwait a fewminutes before attempting
to re-insert. Blade and modular servers are removed when a chassis is removed the Cisco UCS
Manager.

Note

Inserting or Removing all Devices in Cisco UCS Platform Emulator
From the Hardware Inventory Dashboard, you can perform operations such as inserting or removing all the
devices to and from the Cisco UCS Manager. Additionally you can connect or disconnect all the links of the
hardware components. If all the links of a device are disconnected, they are automatically connected and then
inserted. A generic error message
A few devices could not be inserted. Please attempt to insert them manually
is displayed if device(s) could not be inserted due to various reasons.

Removing devices take some time. However, links of the devices are not deleted.
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When you connect all the links of removed FEX, Rack Servers and Chassis, it preserves the current link
configuration and attempts to connect only if all the links are disconnected. A generic error message
A few devices could not be connected
is displayed if device(s) could not be connected due to various reasons.

You can disconnect all the configured links only after the components are removed.Note

Procedure

Step 1 To insert all devices, on the Hardware Inventory dashboard, Click the Insert all devices icon on the right
corner.

Step 2 To remove all devices, on the Hardware Inventory dashboard, Click the Remove all devices icon on the right
corner.

Step 3 To connect all devices, on the Hardware Inventory dashboard, Click theConnect all devices icon on the right
corner.

Step 4 To disconnect all devices, on the Hardware Inventory dashboard, Click the Disconnect all devices icon on
the right corner.

Deleting a Device
You can delete a device from Cisco UCS Platform Emulator, from the following two locations:

• From the Hardware Inventory Dashboard.

• From the Focus page of the device.

Procedure

Step 1 On the Hardware Inventory Dashboard, click theDelete Device icon from the desired hardware device's table.
Step 2 Return to the Hardware Inventory Dashboard and click the Edit Device icon.
Step 3 On the Focus page of the device, click the Delete Device icon on top of the page.

You can delete a device only when it is removed from the Cisco UCSManager.Note

Managing Connectivity of Links Between Devices
You can manage the links between the source device and peer devices using the Links area on the individual
Focus page of the hardware components in theHardware Inventory Dashboard. You can manage links for
chassis, rack servers and fabric extenders.

There are two ways to connect/disconnect links:
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• Manually configure the links using the drop-downmenu which lists compatible peer devices and unused
peer ports.

• Allow Cisco UCS Platform Emulator to connect all links automatically using the Connect All links of
this device option.

Procedure

Step 1 To manually edit a link, on the Hardware Inventory Dashboard area, click the Edit Device icon for the
chassis, rack server, or the FEX you want to modify links for.
The individual Focus page is displayed.

Step 2 In the Links area (for instance, for a chassis it displaysManage Links of Chassis), click Edit Port.
The break-up ports of scalable port 5 are represented as ports 5, 6, 7, 8. A secondary chassis is discovered
only if its IOM links are connected to scalable port of FI-IOM.

Step 3 Select options from the Peer Device Type, Peer Device Id/Side, Peer Slot/Peer Port drop-down lists.
Links of a rack server vary depending on the mode of the rack server.:

• DAS mode— links (carrying both data and management traffic) are created between adapter ports of
the rack server and FI ports.

• SWM mode— links (carrying both data and management traffic) are created between adapter ports of
the rack server and Fex ports.

• DWMmode— links (carrying data traffic) are created between adapter ports of the rack server and Fex
ports.

Additionally, links are created between LOM ports of the rack server and Fex ports to carry management
traffic.

Peer Device of a C3260 chassis varies depending on peer device type selected on Chassis box:Note

• Fabric Interconnect - Chassis' SIOCs are connected to the fabric interconnect with a connectivity
ratio of 1:1.

• Fabric Extender - Chassis' SIOCs are connected to the fabric extender with a connectivity ratio
of 1:1.

Peer Port drop-down shows list of unused ports on a selected peer device. Appropriate success or
error message is displayed on selection of Peer Port.

Step 4 To manually delete a link, return to the Hardware Inventory Dashboard area and click the Edit Device
icon for the chassis, rack server, or the FEX you want to modify links for.
The individual Focus page is displayed.

Step 5 In the Links area (for instance, for a chassis it displaysManage Links of Chassis), click Delete Link.
Step 6 To automatically connect all the links, from the Hardware Inventory Dashboard area click the Edit

Device icon for the chassis, rack server, or the FEX you want to modify links for.
The individual Focus page is displayed.

Step 7 In the Links area (for instance, for a chassis it displaysManage Links of Chassis), click Connect All Links
of this Device..
A message is displayed - Connect All Links of this Device.
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Step 8 Click the green check mark to connect the links or the red cross icon to cancel the action.
Step 9 To automatically disconnect all links, return to the Hardware Inventory Dashboard area and click the

Edit Device icon for the chassis, rack server, or the FEX you want to modify links for.
The individual Focus page is displayed.

Step 10 In the Links area (for instance, for a chassis it displaysManage Links of Chassis), clickDisconnect all Links
of this Device..

Step 11 Repeat step 8, where a similar message is displayed.
Error messages are displayed for incompatible connections. For instance, rack servers in the DAS
and SWMmode cannot be connected to LOM ports. TheConnect All Links of this device preserves
the current link configuration and attempts to connect only the remaining disconnected ports. In case
of failure to find enough ports, an error message is displayed and the current link configuration is
preserved.

For a C3260 System, Cisco UCS Platform Emulator does not support breakout cable connections.
All links are connected in a 1:1 ratio.

Note

Using Existing Hardware Inventory Configurations
You can use existing hardware inventory configurations in theWork pane using the icons on the menu bar.

Importing a Hardware Inventory Configuration File
You can import a hardware configuration file that you exported from one Cisco UCS Platform Emulator into
another Cisco UCS Platform Emulator. You cannot import a backup file from a Cisco UCS domain. If you
want to import the configuration from a Cisco UCS domain, see Importing the Equipment from a Cisco UCS
Domain.

Before You Begin

Changes to this setting do not take effect until you restart Cisco UCS Platform Emulator.

Procedure

Step 1 On the Hardware Inventory Dashboard page, click the Load File icon on the Menu bar.
Step 2 Click Browse and navigate to the file that you want to load into the Cisco UCS Platform Emulator.
Step 3 Restart Cisco UCS Platform Emulator.

Importing the Equipment from a Cisco UCS Domain

Before You Begin

Changes to this setting do not take effect until you restart Cisco UCS Platform Emulator.
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Importing a configuration using HTTPS is now supported. If HTTPS is disabled on a Cisco UCS domain,
enable HTTPS redirection.

Note

Procedure

Step 1 In the Work pane, click the Import icon from the menu bar.
Step 2 Select Import From a Live UCS
Step 3 In theCisco UCS Server field, enter the web link for the Cisco UCSManager GUI of the Cisco UCS domain

from which you want to import the equipment.

The default web link is http://UCSManager_IP:port , where UCSManager_IP represents the IP
address assigned to Cisco UCS Manager. This IP address can be one of the following:

• Cluster configuration: UCSManager_IP represents the virtual or cluster IP address assigned to
Cisco UCS Manager. Do not use the IP addresses assigned to the management port on the fabric
interconnects.

• Standalone configuration: UCSManager_IP represents the IP address for the management port on
the fabric interconnect

And where port represents the port used to access the Cisco UCS Manager GUI. By default, this port is 80
for HTTP access and 443 for HTTPS access.

Step 4 Enter a valid user name and password for the Cisco UCS domain.
Any user with read-only or higher privileges can access the hardware inventory configuration.

Step 5 Click Load.
Step 6 Restart Cisco UCS Platform Emulator. For information on restarting, see Restarting Cisco UCS Platform

Emulator, on page 29

Importing a Saved Hardware Inventory Configuration

When a XML before 2.2(4bPE1) version is imported to the 2.2(4bPE1) setup, storage controllers might
not be added to the rack server if the storage controller slot is same as the adapter slot. If the adapter and
storage controller slots are same, insert the storage controller manually.

Note

Procedure

Step 1 In theWork pane, click the Import icon from the menu bar.
Only a user created configuration file is shown when you try to load a configuration
file.

Note
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Step 2 Select Import from a Saved XML
Step 3 In the menu below, click the link for the hardware inventory configuration you want to load into the Cisco

UCS Platform Emulator.
Step 4 Restart Cisco UCS Platform Emulator. For information on restarting, see Restarting Cisco UCS Platform

Emulator, on page 29

Saving the Current Hardware Inventory Configuration
You can save the current hardware inventory configuration from theWork pane to use in another Cisco UCS
Platform Emulator VM or as a backup for the current VM. The configuration is saved as an XML file.

Procedure

Step 1 On the Hardware Inventory Dashboard page, click the Save the Configuration icon on the menu bar.
Step 2 In the File Name field, enter a name for the configuration file.

The file name must include only alphanumeric chars only, dashes (-) and underscores ( _ ). It cannot include
spaces.

Step 3 Click Save.
The configuration file is saved in Cisco UCS Platform Emulator and added to the saved configuration list.

Exporting the Hardware Inventory Configuration as an XML File
You can save the exported XML file with the hardware inventory configuration and then import it into another
Cisco UCS Platform Emulator or place it on a web server to use as a start up configuration.

Procedure

Step 1 In theWork pane, click the Export icon from the menu bar.
Step 2 Select Export XML

Cisco UCS Platform Emulator opens a new browser tab and displays the contents of the hardware inventory
configuration as an XML file.
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C H A P T E R  7
Accessing Features in Cisco UCS Platform
Emulator

This chapter includes the following sections:

• Starting the Cisco UCS Manager GUI from the Cisco UCS Platform Emulator Control Panel, page 51

• Accessing Cisco Developer Network , page 52

• Accessing Cisco UCS PowerTool, page 52

Starting the Cisco UCS Manager GUI from the Cisco UCS
Platform Emulator Control Panel

You can use the Cisco UCSManager GUI to configure and manage the hardware in your Cisco UCS Platform
Emulator environment.

For information about Cisco UCSManager GUI commands, see the Cisco UCS Manager GUI Configuration
Guide. You can access this document through the Cisco UCS B-Series Servers Documentation Roadmap
available at the following URL: http://www.cisco.com/go/unifiedcomputing/b-series-doc .

Procedure

Step 1 In theWork pane, click the Open UCS Manager tab from the menu bar.
Step 2 Click the Launch UCS Manager tab.
Step 3 If a Security dialog box displays, do the following:

a) (Optional) Check the check box to accept all content from the IP address for Cisco UCS Platform Emulator.
b) Click Yes to accept the certificate and continue.

Step 4 In the Login dialog box, do the following:
a) In the User Name field, enter UCSPE.
b) In the Password field, enter UCSPE.
c) Click Login.
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Accessing Cisco Developer Network
The Cisco Developer Network provides information, documentation, and support resources for developers
working with Cisco UCS. You can also access information and documentation for the Cisco UCS Manager
XML API from the Cisco Developer Network .

Internet access is required in order to access the Cisco UCS Platform Emulator.Note

Procedure

Step 1 In theWork pane, click the Help icon from the menu bar.
Step 2 SelectUCS CDN.

Accessing Cisco UCS PowerTool

Information about Cisco UCS PowerTool
Cisco UCS PowerTool is a Microsoft PowerShell command line toolkit and interface to Cisco UCS. You can
use Cisco UCS PowerTool to integrate, automate, and orchestrate all aspects of Cisco UCS management
within the data center, including network, storage and hypervisor management.

Cisco UCS includes over 2400 PowerShell command-lets (“cmdlets”) that enable you to integrate and automate
Cisco UCS with Microsoft products and many third party products.

Downloading Cisco UCS PowerTool

Cisco UCS Platform Emulator must have access to the internet to download Cisco UCS PowerTool.Note

Procedure

Step 1 In theWork pane, click the Help icon from the menu bar.
Step 2 Select UCS PowerTool Download.
Step 3 In theWork pane, review the information and follow the instructions to download Cisco UCS PowerTool.
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C H A P T E R  8
Using the Managed Object Browser

This chapter includes the following sections:

• Information About the Managed Object Browser, page 53

• Managed Object Browser Page, page 53

• Running a Query in the Managed Object Browser, page 55

Information About the Managed Object Browser
TheManaged Object Browser, or Visore, that you can access through Cisco UCS Platform Emulator provides
you with a graphical view of the managed objects in the XML database. You can also use the Managed Object
Browser to find out what type of data Cisco UCS stores in the database for each type of managed object. In
addition, since the Managed Object Browser uses the Cisco UCS Manager XML API to query the runtime
managed objects and display the results, it also enables you to see the query that was used to obtain the
information from the database.

For example, you can use the Managed Object Browser to see which service profiles have been configured
and the XML query that was used to access that information in the database. You can also use it to view the
type of data stored in the database about servers, such as the number of cores, the type of adapter, or the
number of CPUs. You can then use that information when you design or debug a Cisco UCS domain.

You can also connect to and run queries with the Managed Object Browser on a running Cisco UCS
domain through the following URL: http://UCSManager_IP/visore.html.

Tip

Managed Object Browser Page
Filter Area

The filter form is case sensitive. This area supports all simple Cisco UCS Manager XML API operations.
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DescriptionName

Object class name or full distinguished name of a managed object.Class or DN field

The property of the managed object on which you want to filter the
results. If you leave the Property field empty, the search returns all
instances of the specific class.

Property field

Operator for the values of the property on which you want to filter the
results. The following are valid operators are:

• ==—equal to

• !=—not equal to

• <—less than

• >—greater than

• ≤—less than or equal to

• ≥—greater than or equal to

• between

• wildcard

• anybit

• allbits

Op drop-down list

The first value for the property on which you want to filter.Val1 field

The second value on which you want to filter.Val2 field

Display XML of Last Query Link

The Display XML of last query link displays the full Cisco UCSManager XML API translation of the most
recent query run in the Managed Object Browser.

Results Area

You can bookmark any query results page in your browser to view the results again because the query is
encoded in the URL.

Many of the managed objects are only used internally and are not generally applicable to Cisco UCS
Manager program development.

Note

DescriptionName

Separates individual managed object instances and displays the class
name of the object below it.

Pink background
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DescriptionName

Indicates the property names of the managed object.Blue or green background

Indicates the value of a property name.Yellow or beige background

Absolute address of each managed object in the object model.dn property

When clicked, displays all managed objects with that dn.dn link

When clicked, displays all managed objects of that class.Class name link

When clicked, takes you to the parent object of the managed object.Left arrow

When clicked, takes you to the child objects of the managed object.Right arrow

Links you to the XML API documentation for the managed object.Question mark

Running a Query in the Managed Object Browser
Procedure

Step 1 In theWork pane, click the Help icon from the menu bar.
Step 2 SelectManaged Object Browser.
Step 3 In theWork pane, In the Class or DN field, type the class or DN of the managed object you want to query.

This is the only required field in a query. For information about the available classes or DNs, see the Cisco
UCS Manager XML API documentation.

Example:
If you want to search on all instances of the blade class in the object model, enter computeBlade in the Class
or DN field. However, if you want to limit the query to a specific server, such as blade server 1 in chassis 1,
enter sys/chassis-1/blade-1.

Step 4 (Optional) If you want to filter the results of your query, complete the following fields:
DescriptionName

Enter a property of the managed object on which you
want to filter the results of the search. For example,
if you are querying computeBlade, you could enter
association.

Property field
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DescriptionName

Choose the operator on which you want to filter the
values for the property. This can be:

==, !=, <, >, ≤, ≥, between, wildcard, anybit, allbits

• ==—equal to

• !=—not equal to

• <—less than

• >—greater than

• ≤—less than or equal to

• ≥—greater than or equal to

• between

• wildcard

• anybit

• allbits

Op drop-down list

Enter an available value for the property entered in
the Property field. For example, if you are filtering
on the association property, you could enter
unassociated.

Val1 field

Enter an available second value for the property
entered in the Property field.

Val2 field

Step 5 Click Run Query
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C H A P T E R  9
Accessing the Cisco UCS Manager XML API
Documentation

This chapter includes the following sections:

• Information About the Cisco UCS Manager XML API, page 57

• Information About the Cisco UCS Manager XML API Documentation, page 58

• Accessing the Cisco UCS Manager XML API Documentation, page 58

Information About the Cisco UCS Manager XML API
The Cisco UCS Manager XML API is a programmatic interface to Cisco Unified Computing System (UCS).
The API accepts XML documents through HTTP or HTTPS. Developers can use any programming language
to generate XML documents that contain the API methods. Configuration and state information for Cisco
UCS is stored in a hierarchical tree structure known as the management information tree, which is completely
accessible through the XML API.

The Cisco UCS Manager XML API supports operations on a single object or an object hierarchy. An API
call can initiate changes to attributes of one or more objects such as chassis, blades, adapters, policies, and
other configurable components.

The API operates in forgiving mode. Missing attributes are replaced with applicable default values that are
maintained in the internal data management engine (DME). The DME ignores incorrect attributes. When
multiple managed objects (MOs) are being configured, the API operation stops if any of the MOs (a virtual
NIC, for example) cannot be configured. In that case, the management information tree is rolled back to the
prior state that preceded the API operation and an error is returned.

Updates to MOs and properties conform to the existing object model to ensure backward compatibility. If
existing properties are changed during a product upgrade, they are managed during the database load after
the upgrade. New properties are assigned default values.

Operation of the API is transactional and terminates on a single data model. Cisco UCS is responsible for all
endpoint communication, such as state updates. Users cannot communicate directly to endpoints, which
relieves developers from administering isolated, individual component configurations.

The API model includes the following programmatic entities:

• Classes—Define the properties and states of objects in the management information tree.
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• Methods—Actions that the API performs on one or more objects.

• Types—Object properties that map values to the object state (for example, equipmentPresence).

A typical request comes into the DME and is placed in the transactor queue in FIFO order. The transactor
gets the request from the queue, interprets the request, and performs an authorization check. After the request
is confirmed, the transactor updates the management information tree. This complete operation is done in a
single transaction.

Full event subscription is enabled. After subscribing, any event notification is sent along with its type of state
change.

Information About the Cisco UCS Manager XML API
Documentation

The Cisco UCS Manager XML API documentation that you can access through the Cisco UCS Platform
Emulator provides information about the Cisco UCS Manager information model

When you view the XMLAPI documentation, the navigation frames on the left list the following information:

• Managed objects

• Methods

• Types

• Fault rules

• Finite State Machine (FSM) rules

For more information about the Cisco UCS Manager XML API, see the Cisco UCS Manager XML API
Programmer's Guide.

Accessing the Cisco UCS Manager XML API Documentation
The XML API docs are displayed in theWork pane. The links provide navigation through the information
model.

Procedure
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